Table of Contents

Section 1 .................................................................1-1
Introduction ........................................................................................................1-1
1.1 Overview .................................................................................................1-1
1.2 Keen+ Features ......................................................................................1-1
1.2.1 Device Support ..................................................................................1-2

Section 2 2-1
Getting Started .............................................................................................2-1
2.1 Unpacking the System ...........................................................................2-1
2.2 System Requirements ...........................................................................2-1
2.3 Software Installation .............................................................................2-1
2.4 Quick Start ..............................................................................................2-2
2.4.2 Programming Keen+ ........................................................................2-3

Section 3 3-1
Hardware Description ....................................................................................3-1
3.1 Description of 10-pin Debug header .....................................................3-2
3.2 Description of 2x5-pin PORTD Header ..................................................3-2
3.3 Description of User LEDs ......................................................................3-3
3.4 Description of USB Interface ..................................................................3-4
3.5 Description of JTAG Header ..................................................................3-4
3.6 Description of ISP Header ......................................................................3-5
3.7 Miscellaneous .........................................................................................3-5
3.7.1 RESET ..............................................................................................3-6
3.7.2 HWB Button ......................................................................................3-6
3.7.3 Power LED .......................................................................................3-6

Section 4 4-1
Installing AVR Studio ..................................................................................4-1

Section 5 5-1
Using AVR Studio to Program Keen+ ..........................................................5-1
5.1 Connecting Keen+ to AVR Studio .........................................................5-1
5.2 Starting AVR Studio ..............................................................................5-1
5.2.1 Connecting to Keen+ from AVR Studio ............................................5-1
5.3 Program AVR User Interface .................................................................5-3
5.3.1 Main Tab ...........................................................................................5-3
5.3.2 Program Tab ....................................................................................5-4
5.3.3 Fuses Tab ........................................................................................5-6
5.3.4 LockBits Tab ...................................................................................5-8
5.3.5 Auto Settings ...................................................................................5-9
5.3.6 History Window ...............................................................................5-10

Section 6 6-1
Installing FLIP ..............................................................................................6-1

Section 7 7-1
Using FLIP to Program Keen+ .......................................................................7-1
7.1 Starting FLIP ........................................................................................7-1
7.2 Connecting FLIP to Keen+ ....................................................................7-1
7.3 Programming Hex File to Keen+ ............................................................7-2
<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>7.4</td>
<td>7-4</td>
</tr>
<tr>
<td>Section 8</td>
<td>8-1</td>
</tr>
<tr>
<td>Technical Specifications</td>
<td>8-1</td>
</tr>
<tr>
<td>Section 9</td>
<td>9-1</td>
</tr>
<tr>
<td>Troubleshooting Guide</td>
<td>9-1</td>
</tr>
<tr>
<td>Section 10</td>
<td>10-1</td>
</tr>
<tr>
<td>Technical Support</td>
<td>10-1</td>
</tr>
<tr>
<td>Section 11</td>
<td>11-1</td>
</tr>
<tr>
<td>Complete Schematics</td>
<td>11-1</td>
</tr>
<tr>
<td>Appendix 1</td>
<td>1</td>
</tr>
<tr>
<td>Figures &amp; Tables Index</td>
<td>1</td>
</tr>
<tr>
<td>Figures Index</td>
<td>1</td>
</tr>
<tr>
<td>Tables Index</td>
<td>1</td>
</tr>
</tbody>
</table>
Keen+ is a complete development kit for secure RFID applications using CryptoRF® on an AVR platform and AT88RF1354 RF reader. It is designed to give designers a quick start to develop code for CryptoRF on an AVR and for prototyping and testing of designs for CryptoRF.

All the necessary hardware is provided in the package and the microcontroller on-board is already programmed. All that you need to communicate with a CryptoRF tag is to plug the USB cable and run the Crypto Evaluation Studio which is provided in the CD.

1.1 Overview

This document describes the Keen+ board which is designed to allow an easy evaluation of the CryptoRF products and also for prototyping and testing of designs for CryptoRF. This user guide acts as a general getting started guide as well as a complete technical reference for advanced users.

1.2 Keen+ Features

Keen+ provides the following features:

- AT90USB647
- AT88RF1354 RF reader
- AVR Studio® software interface
- USB Interface to PC
- ISP connector for on-chip ISP (In-System Programming)
- Reprogramming of AVR microcontroller
- JTAG Connector for on-chip debugging
- 1 2X5-pin header connected to PORTD of AT90USB647
- 1 Hardware Boot loader (HWB) Push Button
- 1 1X10-pin Debug header (H1) connected to digital pin of AT88RF1354 RF reader
- 8 MHz crystal for system clock

Keen+ supports AVR Studio, version 4.14 (build 589) and higher. For up-to-date information on this and other AVR products, please visit [www.atmel.com/products/AVR](http://www.atmel.com/products/AVR).
1.2.1 Device Support

Keen+ currently has support for the following CryptoRF devices:

- AT88SC0104CRF
- AT88SC0204CRF
- AT88SC0404CRF
- AT88SC0808CRF
- AT88SC1616CRF
- AT88SC3216CRF
- AT88SC6416CRF

Section 2
Getting Started

2.1 Unpacking the System

Package content:
- 1 Keen+ board
- 1 Crypto Solutions CD
- Atmel CryptoRF Tag Assortment
- 1 USB cable
- Quick Start Guide

2.2 System Requirements

The minimum hardware and software requirements are:
- Intel® Pentium® 200MHz processor or equivalent
- 256 MB memory
- 200 MB free hard disk space (AVR Studio, FLIP and Crypto Evaluation Studio)
- Windows® XP
- Available USB Port

2.3 Software Installation

1. Insert Crypto Solutions CD into the PC.
2. Select the “Detailed Information” option.
3. Click “Install Now” to install Crypto Evaluation Studio and other resources. This will place program icons on the desktop as well as the start menu.
2.4 Quick Start

Figure 2. Connection from PC to Keen+

1. Connect Keen+ to your PC using the provided USB cable Figure 2. The blue Power LED is lit when power is available.
2. Start Crypto Evaluation Studio from "Start menu > All Programs > Atmel > ECS Resource Center" folder or direct ECE Studio Icon placed on the desktop.
3. Follow the instructions at the bottom of each screen.
4. Click forward to advance screen.
5. See Help menu for detailed information on how to use Crypto Evaluation Studio.
2.4.2 Programming Keen+

Keen+ can be programmed using AVR Studio version 4.14 (build 589) and higher or FLIP version 3.3.2 and higher. Instructions on how to install AVR Studio are given in Section 4 on page 4-1. Instructions on how to install FLIP are given in Section 6 on page 6-1.

2.4.2.1 Programming Keen+ with AVR Studio using ISP or JTAG

**Note:** STK500 (ISP) connection is capable of supplying power to Keen+, which is necessary to program the board. AVRISP mkII and JTAG mkII are not capable of supplying power to Keen+, and therefore a USB connection is required to power the board. A powered Keen+ is indicated by a blue LED.

1. Start AVR Studio from "Start menu > All Programs > Atmel AVR Tools" folder.
2. Select "Tools > Program AVR > Connect" menu in AVR Studio.
3. Select the programmer device in "Platform" list box and also the port that is connected to the programmer. Press "Connect" button.
4. In "Main" tab, select AT90USB647 from the pull down menu and then press "Read Signature" button.
5. In "Program" tab, locate the intel-hex file by pressing [button] in "Flash" section and then press "Program" button.

Complete descriptions of using Keen+ with AVR Studio are given in Section 5 on page 5-1.

**Note:** Programming Keen+ using ISP or JTAG will erase the bootloader in Keen+. The bootloader is required in order to use FLIP

2.4.2.2 Programming Keen+ with FLIP using USB

**Note:** *Keen+ is shipped with the bootloader installed, which allow programmers to use FLIP. However if ISP or JTAG was previously used to program Keen+, the bootloader was erased. To use FLIP, the bootloader must be reloaded with ISP or JTAG and then FLIP can be used.*

1. Start FLIP from "Start menu > All Programs > Flip <version_number>" folder.
2. Make sure that Keen+ is already in the Device Firmware Upgrade (DFU) mode. Read Section 3.7.2 for more information about starting DFU mode.
3. Select "Device > Select..." menu. Choose AT90USB647 and press "OK" button.
4. Press "Select a Communication Medium" button and select "USB". After "USB Port Connection" window appear, press "Open" button.
5. When FLIP has been connected to Keen+, select "File > Load hex File..." menu and browse to the hex file.
6. To start programming, press "Run" button.

Complete descriptions of using Keen+ with FLIP are given in Section 7 on page 7-1.
Section 3
Hardware Description

Figure 3. Keen+ Components (front side)
- JTAG Header
- User LEDs
- AT90USB647
- Debug Header
- USB Connector
- PORTD Header
- ISP Header
- AT88RF1354
- Antenna

Figure 4. Keen+ Components (back side)
- Crystal
- Antenna
3.1 Description of 10-pin Debug header

Keen+ has 10-pin Debug header which is connected to digital pins of AT86RF1354. The block schematic of Debug header is shown in Figure 5.

*Figure 5.* 10-pin Debug Header

- CLKO
- RSTB
- ISEL
- ISTAT
- SSB
- SCK
- SDI
- SDO
- ADDR

3.2 Description of 2x5-pin PORTD Header

2x5-pin PORTD header is connected to PORTD of AT90USB647, GND pin and VCC pin as shown in Figure 6.

*Figure 6.* 2x5-pin PORTD Header

```
1  2
PD0 PD1
PD2 PD3
PD4 PD5
PD6 PD7
GND VCC
```
3.3 Description of User LEDs

Keen+ has 3 red LEDs which are connected to PE3, PE6 and PE7. They can be used for any kind of indication or debug purposes.

*Figure 7. Implementation of User LEDs*

```
  \[ L1 \quad R121 \quad \text{PE7} \]
\[ L2 \quad R122 \quad \text{PE6} \]
\[ L3 \quad R124 \quad \text{PE3} \]
```

*Note:* AVR can source or sink enough current to drive an LED directly.
3.4 Description of USB Interface

Keen+ has one USB port. The USB port is used to provide power and for communication between AVR microcontroller in Keen+ and PC.

*Figure 8. USB Interface Schematic*

Pads available to connect case to grid

3.5 Description of JTAG Header

JTAG header allows users to upload and debug their application with the JTAG programmer.

*Figure 9. The JTAG Header*
3.6 Description of ISP Header

The ISP Header can be used to program Keen+ through In-System Programming. ISP header has VTG pin that can supply power to Keen+.

Figure 10. 6-pin ISP Connector Pinout

<table>
<thead>
<tr>
<th>Pin</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>SDO</td>
</tr>
<tr>
<td>2</td>
<td>VCC</td>
</tr>
<tr>
<td>3</td>
<td>SCK</td>
</tr>
<tr>
<td>4</td>
<td>SDI</td>
</tr>
<tr>
<td>5</td>
<td>RST</td>
</tr>
<tr>
<td>6</td>
<td>GND</td>
</tr>
</tbody>
</table>

3.7 Miscellaneous

Keen+ Kit has 2 push buttons and 1 Power LED. The following section explains these features. Figure 11 shows the placement of these buttons and Power LED.

Figure 11. Special Function Buttons and Power LED
3.7.1  **RESET**

The “RESET” push button resets the target AVR device when pushed.

3.7.2  **HWB Button**

The “HWB” push button is used to place the AVR into DFU mode (bootloader).

The HWB mode of this pin is active only when the HWBE fuse is enabled.

The following steps enable the DFU mode:

1. Press and hold the “HWB” push button.
2. Press the “RESET” push button.
3. Release the “RESET” push button.
4. Release the “HWB” push button.

3.7.3  **Power LED**

The blue Power LED is directly connected to VCC pin of USB connector. The Power LED is always lit when power is available in USB connector.
Section 4
Installing AVR Studio

AVR Studio, with its Integrated Development Environment (IDE), is the ideal software for all AVR development. It has an editor, an assembler and a debugger and is front-end for all AVR emulators.

To install AVR Studio, insert the supplied Atmel CD-ROM and then execute the "AvrStudio4Setup.exe" file. This will guide you through the setup process.

**Note:** AVR Studio, version 4.14 (build 589) and higher, is required for Keen+ support.
Section 5

Using AVR Studio to Program Keen+

5.1 Connecting Keen+ to AVR Studio

Keen+ can be programmed from AVR Studio using ISP or JTAG. Before programming Keen+, connect Keen+ ISP header to ISP programmer or Keen+ JTAG header to JTAG programmer.

5.2 Starting AVR Studio

AVR Studio, version 4.14 (build 589) and higher could be used for programming the Keen+. For information on how to install this software, please see Section 4. Once installed, AVR Studio can be started by double clicking on the AVR Studio icon. The program is located in the Windows “Start menu > All Programs > Atmel AVR Tools” folder.

5.2.1 Connecting to Keen+ from AVR Studio

Start the “Select AVR Programmer” dialog by pressing the button on the AVR Studio toolbar. This brings up the following dialog:

![Select AVR Programmer Dialog]

Select a platform and port, and press the “Connect” button to connect to the given platform. The programming front-end will appear after a few seconds.

To connect directly to the platform and port that was selected the last time the “Select AVR Programmer” dialog was open, press the button in the toolbar.
If the selected platform cannot be detected, the “Select AVR Programmer” dialog will reappear after a few seconds. If this happens, check that the RS232 or USB cable is properly connected and that the tool is not already connected in a debug or programming session in the same or another instance of AVR Studio.

Figure 13. “Program AVR” User Interface
5.3 Program AVR User Interface

The “Program AVR” user interface includes powerful features for the Keen+ development kit. The available settings are divided into eight groups, each selectable by clicking on the appropriate tab. Since different devices have different features, the available options and selections will depend on which device is selected. Unavailable features are grayed out. For more information about AVR Studio, read AVR Studio User Guide from AVR Studio Help menu.

5.3.1 Main Tab

The device and programming mode is selected in the “Main” tab. This tab also contains buttons for erasing the device and reading the signature.

Figure 14. “Main” Tab
5.3.1.1 Device and Signature Bytes

The correct device and programming interface must be set before any programming operations.
Select the device in the Device combo-box. This makes sure that the correct programming algorithms are used for the device, and that only features that are available for the device are displayed in the dialog. Next, specify the programming interface as described in the following section.

Pressing the "Read Signature" button reads the device’s signature. The dialog checks if the signature matches the selected device. Please refer to the AVR datasheet to read more about signature bytes.

A full chip-erase is performed by pressing the "Erase Device" button. This erases the entire contents of the connected device, including Flash, EEPROM (unless the EESAVE fuse is programmed) and lock-bits.

5.3.1.2 Programming Mode and Target Settings

The programming interface between the tool and the target device is shown here. Currently, the available programming interfaces are:

- ISP (In-System Programming)
- PP/HVSP (High-Voltage Parallel or Serial Programming)
- JTAG
- PDI (For Xmega family only)

If either ISP or JTAG is selected, further settings for the interface can be specified by clicking the “Settings” button. There are no further settings for the PP/HVSP interface.

5.3.2 Program Tab

The “Program” tab allows memory programming, as well as performing a chip erase.

5.3.2.1 Device

A full chip erase is performed by pressing the “Erase Device” button. The check boxes specify options for subsequent programming which are:

- A chip-erase can be performed before memory programming operations.
- Memory programming can be automatically verified.
5.3.2.2 Flash

The Flash contents of the connected device can be programmed, verified and read out by pressing the appropriate buttons. Before the Flash can be programmed, the input file must be specified.

If the source code is stored in a HEX file, select the "Input HEX File" option. Browse to the correct file by pressing the button, or write the complete path and filename in the text field. The selected file must be in "Intel-hex" format or "extended Intel-hex" format.

Figure 15. "Program" Tab
5.3.3 Fuses Tab

The "Fuses" tab presents the fuses of the selected device.

Press the "Read" button to read the current value of the fuses, and the "Write" button to write the current fuse setting to the device. Fuse settings are presented as check boxes or as drop down lists.

Detailed information on which fuses are available in the different programming modes and their functions can be found in the device data sheet. Note that the selected fuse setting is not affected by erasing the device with a chip-erase cycle (i.e. pressing "Chip Erase" button in the "Program" settings).

Fuse values can also be written directly into the Extended, High and Low fuse registers in the lower pane.

The checked boxes at the bottom specify:

- The fuses in the device should be read automatically when the fuse tab is displayed.
- Warnings should be displayed if the user selects a potentially dangerous fuse setting.
- Fuses should be automatically verified after programming.

Verify these fuse settings:

- If programming using JTAG, make sure "JTAG Interface Enabled" is checked.
- If programming using SPI, make sure “Serial program downloading (SPI) Enabled” is checked.
- Make sure “Divide clock by 8 internally” is checked.
- Make sure “ExtCrystal Osc; Frequency 8.0- MHz; start up time: 16 CK + 65 ms” is selected.
- Make sure that HWBE is checked.
- Make sure that BOOTSZ value is “Boot Flash size=2408 words start address=7C00”.
Figure 16. “Fuses” Tab

![Keen+ User Guide](STK500 in ISP mode with AT90USB647)

<table>
<thead>
<tr>
<th>Tab</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>BODLEVEL</td>
<td>Brown-out detection at VCC=2.6 V</td>
</tr>
<tr>
<td>HW/BE</td>
<td>✔</td>
</tr>
<tr>
<td>OCDEN</td>
<td></td>
</tr>
<tr>
<td>JTAGEN</td>
<td>✔</td>
</tr>
<tr>
<td>SPIEN</td>
<td>✔</td>
</tr>
<tr>
<td>WDTON</td>
<td></td>
</tr>
<tr>
<td>EE SAVE</td>
<td></td>
</tr>
<tr>
<td>BOOTSZ</td>
<td>Boot Flash size=2409 words start address=$7C00</td>
</tr>
<tr>
<td>BOOTRST</td>
<td></td>
</tr>
<tr>
<td>CKDIV8</td>
<td>✔</td>
</tr>
<tr>
<td>CKOUT</td>
<td></td>
</tr>
<tr>
<td>SUT_CKSEL</td>
<td>Ext. Crystal Osc. 8.0 MHz; Start-up time: 258 CK + 65 ms</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Extended</th>
<th>Address</th>
</tr>
</thead>
<tbody>
<tr>
<td>HIGH</td>
<td>0x9B</td>
</tr>
<tr>
<td>LOW</td>
<td>0x5E</td>
</tr>
</tbody>
</table>

- Auto read
- Smart warnings
- Verify after programming

Entering programming mode. OK!
Reading fuses address 0 to 2. 0x5E, 0x9B, 0xF3.. OK!
Leaving programming mode. OK!
5.3.4 LockBits Tab

Similar to the "Fuses" tab, the "LockBits" tab shows which lock modes are applicable to the selected device.

A lock mode may consist of a combination of setting multiple lock bits. This is handled by programmer, and the correct lock bits are programmed automatically for the selected Lock mode. Once a "Lock mode" protection level is enabled it is not possible to lower the protection level by selecting a "lower" degree of protection by setting a different "Lock mode".

The only way of removing a programmed lock bit is to do a complete chip-erase. Verify that “LockBits” setting match the “LockBits” setting in figure below.

Figure 17. “LockBits” Tab
### 5.3.5 Auto Settings

When programming multiple devices with the same code, the “Auto” tab offers a powerful method of automatically going through a user-defined sequence of commands. The commands are listed in the order they are executed (if selected). To enable a command the appropriate check box should be checked. E.g. If only “Program FLASH” is checked, by pressing the “Start” button the Flash memory will be programmed with the HEX file specified in the "Program" settings.

![Figure 18. “Auto” Tab](image)

It is possible to log the command execution to a text file by checking the "Log to file" check box.
5.3.5.1 Setting Up the System for Auto-programming

Click on the check boxes for the commands that you want the User Interface to perform. A typical sequence is when the device is erased and then programmed in one cycle. The chip is erased, both memories are programmed and verified, and finally fuses and lock bits are programmed.

Once configured, the same programming sequence is executed every time the "Start" button is pressed. This reduces both work and possibilities for errors due to operational errors.

5.3.5.2 Logging the Auto-programming to a File

By clicking on the "Log to file" check box all output from the commands are written to a text file. The file is selected/created by pressing the "Browse" button, and navigate to the location where the file is placed, or should be created. All output are directed to this file, and can be viewed and edited using a text editor.

5.3.6 History Window

The “History” window is located at the bottom of the “Program AVR” user interface view. In this window the dialog between AVR Studio and AVR programmer is shown. For every new command performed, the old dialog is replaced with the new one.
FLIP (FLexible In-system Programmer) is a PC-application which allow users to program and configure Atmel's microcontroller devices in-system. To install FLIP, insert the supplied Atmel CD-ROM and then execute the “Flip Installer - <version_number>.exe”. This will guide you through the setup process.
Section 7
Using FLIP to Program Keen+

7.1 Starting FLIP

FLIP, version 3.3.2 and higher could be used for programming the Keen+ through USB. For information on how to install this software, please see Section 6. Once installed, FLIP can be started by double clicking on the FLIP icon. The program is located in the Windows "Start menu > All Programs > Flip <version_number>" folder.

Figure 19. Atmel FLIP User Interface

Further information on how to use FLIP can be read from FLIP Help menu.

7.2 Connecting FLIP to Keen+

1. Connect Keen+ to the PC's USB port.
2. By default, Keen+ contains a FLIP compliant bootloader program.
3. Press and hold the “HWB” push button.
4. Press the “RESET” push button.
5. Release the “RESET” push button.
6. Release the “HWB” push button.
7. Select a device from the device list:
   From the top menu bar, execute “Device > Select”. The device selection dialog box pops up.
   Select AT90USB647 from the devices list box and click “OK” button.

![Device Selection Dialog]

8. Select a communication medium:
   From the top menu bar, execute “Settings > Communication > USB”. The “USB Port Connection” dialog box pops up. Click “Open” button

![USB Port Connection Dialog]

FLIP starts a synchronization sequence with the target device bootloader software. After the synchronization sequence completion, FLIP reads the target device special bytes and updates the main window frame on the right.

### 7.3 Programming Hex File to Keen+

1. Execute “File > Load HEX File”.

---

7-2 Keen+ User Guide
2. Select the HEX file to be loaded from the browser dialog. When parsing HEX file completes, FLIP updates the following information in the Buffer Information frame of the main window:

- Address range: read from the parsed HEX file
- Checksum: a simple sum of address range contents
- HEX file name
- HEX file size

FLIP keeps track of the last visited directory and the six last loaded HEX files.

3. Press "Run" button to start programming Keen+.

*Figure 22. Buffer Information*
7.4  Viewing the Buffer Content

From the top menu bar, execute “Buffer > Edit”. The “Edit FLASH Buffer” window pops up and shows the content of the buffer.

Figure 23. Buffer Content
Section 8
Technical Specifications

- System Unit
  - Physical Dimensions: L=152 x W=58 x H=15 mm
  - Weight: 34 g

- Operating Conditions
  - Internal Voltage Supply: 5V
  - External Voltage Supply: 5V DC (500mA) minimum Power Supply

- Connections
  - USB Connector: Mini B receptacle
  - USB Communications: Full speed/low speed
### Table 1. Troubleshooting Guide

<table>
<thead>
<tr>
<th>Problem</th>
<th>Reason</th>
<th>Solution</th>
</tr>
</thead>
<tbody>
<tr>
<td>The blue Power LED is not on.</td>
<td>USB Port of Keen+ is not connected to PC.</td>
<td>Connect Keen+ USB port to PC’s USB port.</td>
</tr>
<tr>
<td>The AVR device cannot be programmed.</td>
<td>The JTAG header is not connected to JTAG programmer.</td>
<td>Connect the JTAG header to the JTAG programmer.</td>
</tr>
<tr>
<td></td>
<td>The target ISP header is not connected.</td>
<td>Connect the 6-pin flexible cable from ISP header to ISP header on ISP programmer.</td>
</tr>
<tr>
<td></td>
<td>The memory lock bits are programmed.</td>
<td>Erase the memory before programmed.</td>
</tr>
<tr>
<td>Reset disable fuse is set.</td>
<td>Programming too fast with ISP SPI</td>
<td>Check oscillator settings and make sure it is not set higher than SPI clock</td>
</tr>
<tr>
<td></td>
<td>USB Port of Keen+ is not connected to PC (programmed through USB).</td>
<td>Connect Keen+ USB port to PC’s USB port.</td>
</tr>
<tr>
<td>Keen+ is not in DFU mode.</td>
<td></td>
<td>— Press and hold the “HWB” push button.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>— Press the “RESET” push button.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>— Release the “RESET” push button.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>— Release the “HWB” push button.</td>
</tr>
<tr>
<td>The communication medium in FLIP hasn’t been selected</td>
<td></td>
<td>From the FLIP menu, select “Settings &gt; Communication &gt; USB”.</td>
</tr>
<tr>
<td>AVR Studio does not detect JTAG or ISP programmer.</td>
<td>JTAG or ISP programmer is not connected or power is off.</td>
<td>Connect JTAG programmer to JTAG header or ISP programmer to ISP header and check power connections.</td>
</tr>
<tr>
<td>FLIP program not working.</td>
<td>Keen+ is not in DFU mode.</td>
<td>Use ISP or JTAG to load the bootloader and set (check) the HWBE fuse. Refer to Figure 16 for correct fuse settings.</td>
</tr>
</tbody>
</table>
For technical support, please contact securerf@atmel.com. When emailing or contacting tech support, please do not include any proprietary information you may have input into the device.
VSS_ANT AND VSS_DIG ARE CONNECTED AT A SINGLE POINT NEAR C56/C59

VSS_A AND VSS_DIG ARE CONNECTED AT A SINGLE POINT NEAR C4
Appendix 1
Figures & Tables Index

Figures Index

Figure 1. Keen+ ........................................................................................................................... 1-2
Figure 2. Connection from PC to Keen+ ..................................................................................... 2-2
Figure 3. Keen+ Components (front side) ................................................................................... 3-1
Figure 4. Keen+ Components (back side) ................................................................................... 3-1
Figure 5. 10-pin Debug Header Schematic .................................................................................. 3-2
Figure 6. 2x5-pin PORTD Header ................................................................................................ 3-2
Figure 7. Implementation of User LEDs ...................................................................................... 3-3
Figure 8. USB Interface Schematic .............................................................................................. 3-4
Figure 9. The JTAG Header .......................................................................................................... 3-4
Figure 10. 6-pin ISP Connector Pinout ....................................................................................... 3-5
Figure 11. Special Function Buttons and Power LED ................................................................. 3-5
Figure 12. “Select AVR Programmer” Dialog ............................................................................. 5-1
Figure 13. “Program AVR” User Interface .................................................................................. 5-2
Figure 14. “Main” Tab ................................................................................................................. 5-3
Figure 15. “Program” Tab ............................................................................................................ 5-5
Figure 16. “Fuses” Tab ................................................................................................................ 5-7
Figure 17. “LockBits” Tab ............................................................................................................ 5-8
Figure 18. “Auto” Tab .................................................................................................................. 5-9
Figure 19. Atmel FLIP User Interface ......................................................................................... 7-1
Figure 20. “Device Selection” Dialog ......................................................................................... 7-2
Figure 21. “USB Port Connection” Dialog ................................................................................... 7-2
Figure 22. Buffer Information ...................................................................................................... 7-3
Figure 23. Buffer Content ............................................................................................................ 7-4

Tables Index

Table 1. Troubleshooting Guide ................................................................................................... 9-1